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Disclaimer notice

All information in this manual is accurate as of April 2012. However, the Laboratory for Electromagnetic Innovations cannot be held liable for any damage caused by possible inaccuracies in the Manual.
The Laboratory for Electromagnetic Innovations reserves the right to make corrections, modifications, enhancements, improvements, and other changes to its products at any time and to discontinue any product or service without notice. The Customer is advised to obtain the latest relevant information before placing orders and verify that such information is current and complete. 
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1. Destination

Induction coil magnetometer lemi-30 with data processing system (further – magnetometer) is intended for the measurement of the magnetic field variations in low-noise areas. A complete system consist of three induction coil magnetic sensors LEMI-30 and communication and data acquisition system CAM-Unit with digital output + software for WINDOWS driven stationary personal computer or notebook.
2. Main Technical Parameters of Magnetometer

2.1. Each of three LEMI-30 Induction-coil sensors has following parameters:


	Frequency band of measured signals
	0.001—30 Hz

	Measuring range
	±200nT

	Transformation factor 

                            from 0.001 Hz to 1 Hz

                            from 1 Hz to 30 Hz
	20f mV/nT*

20 mV/nT

	Full band transformation factor error
	3 dB

	Magnetic noise level at 

                            0.01 Hz

                            0.1 Hz

                            1 Hz

                            10 Hz
	20 pTHz-1/2

2 pTHz-1/2

0.2 pTHz-1/2

0.04 pTHz-1/2

	Mains interference rejection
	>60 dB

	Power supply
	(6…15) V,  15 mA

	Temperature range of operation
	- 10 — +50oC

	Operation humidity
	Up to 95%

	Dimensions
	87085 mm

	Weight 
	5.7 kg

	Length of connecting cable 
	Up to <200m on request


*  f is the frequency of the received signal.

.


2.2. CAM-Unit has following parameters:

	Number of inputs
	3

	Frequency band
	0.001—40 Hz

	Input signals range:

  - max input range

  - with resolution

  - min input range

  - with resolution
	8 Vptp*

488  nV/bit*

8 mVptp*

0.488 nV/bit*

	Full band transformation coefficient error
	3 dB

	Sampling frequency of each channel
	Up to 256 Hz

	Programmable system gain 
	1,10,100,1000

	CAM-Unit input
	3 differential inputs 

	ADC resolution
	24 digits

	Timing
	GPS

	Power consumption of the whole system (including 3 sensors, notebook not included)
	12(9-18)V, 250mA
(3W)

	Temperature range of operation
	- 10 — +50C

	Operation humidity
	Up to 85%

	Dimensions
	23521692 mm

	Weight
	1 kg


3. Delivery Set

The magnetometer delivery set includes:
	№
	Item
	Quantity

	1
	Induction coil magnetometer LEMI-301
	6

	2
	Cam-Unit2
	2

	3
	Power supply unit 
	2

	4
	Interface cable
	2

	5
	Converter USB2.0TORS232
	2

	6
	GPS antenna
	2

	7
	Technical Description and Operation Manual
	1

	8
	PC operation software
	


1 #394, #425, #426, #431, #435, #437

2 #04, #05
4. Service, Shelf Life and Guarantee


4.1. Mean lifetime of the LEMI-30 magnetometer – about 10 years.


4.2. Mean lifetime of the CAM-Unit – about 10 years.


4.2. The term of guarantee is 1 year after delivery if all requirements of the present instruction as to applied voltage, weather conditions, vibrations and shocks are observed. During this term the manufacturer is liable to repair the defects occurred through no fault of the consumer or force majeure, or if not possible, to change the device by other equivalent specimen.


4.3. The manufacturer maintains its obligations to make free service and repair the magnetometer if necessary for still 2 years (with full guarantee 3 years in total). By this the user has to cover the necessary spare parts and transportation/visit fees only.


Delivery date:  20.04.2012

[image: image2]
Signature

All questions as to the magnetometer structure and operation have to be addressed to the designer: pron@isr.lviv.ua.

5. Structure and Operation

5.1. The complete set of the magnetometer measuring system includes three LEMI-30 sensors, one communication unit (CAM Unit) and accessories (cables, GPS antenna and PC software) and portable PC. The total system layout is given on Fig. 1.

5.2. The functional diagram of the magnetometer is shown on Fig. 2. 


5.3. All three LEMI-30 sensors have similar construction and characteristics. 


5.4. Each of LEMI-30 sensors consists of the Induction-coil and two PCB fixed inside the protective housing. The front panel of the sensor has the connector for cable coupling. 


The functional diagram of the LEMI 30 sensor is presented on Fig. 3.


5.5. Induction coil sensor consists of mu-metal sensor core SC, main winding Wm, additional winding Wc and two feedback windings Wf1 and Wf2.


Sensor core is made of a number of insulated tapes of high permeability amorphous alloy, and is fixed inside the tubular housing on which all windings are wound.

5.6. Each of PCB is fastened both to the sensor core housing and to the front panel and protected by electrostatic shield. The main winding Wm is connected to low-noise MDM (modulator-demodulator) amplifier A1 input. Local feedback loop inside A1 installs total amplification coefficient at low frequencies equal to approximately 250.


The output of A1 amplifier is coupled through resistor R4 to main magnetic flux feedback winding Wf1 and additional feedback winding Wf2. Magnetic feedback forms the flat part of the transfer function of magnetometer within the frequency band 1 ... 30 Hz. 


The A1 output is coupled also to a low-pass filter - band stop filter  A3, which provides deep rejection of frequencies higher than 30 Hz, output of the A3 amplifier is connected with the input of A4 amplifier which forms the main low level output with the value of transformation factor as given in it.2.1 (output “outs”). The output inverter A5 serves for the formation of the differential output with the same value of the transformation factor (output “outc”). 
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Fig. 1. Total System Layout.
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Fig. 2. The System Functional Diagram.
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Fig.3. Functional Diagram of Induction Coil Sensor LEMI-30.

Additional noise suppression at frequencies near to mains frequency is provided by the compensation of the magnetic field with this frequency along the sensor core. It is realized with the negative magnetic feedback channel which includes an additional winding of compensation channel Wc, tuned at 50 Hz frequency with capacitor C1, low-noise selective amplifier A2, also tuned at 50 Hz, and feedback loop C2-R3-R1-Wf1-R2-Wf2. The proper choice of amplification coefficient of A2 and feedback loop parameters allows to compensate the major part of the measured magnetic field along Wm at frequency (50 ± 1) Hz.

As a result, the total suppression of noise at frequency near to 50 Hz is more than 60 dB what assures that very small signals can be measured at considerable 50 Hz interference level background.


The main sensor winding Wm is coupled in parallel with Zener diodes (not shown at Fig. 3) in order to protect the input elements of A1 amplifier from damage by overloading signals.

5.7. To working capacity check the sensors 10 Hz sin wave signal can be applied to pin B. Applying 5Vptp produces about 2 nTptp signal at the sensor output.

5.8. The housing of the induction coil sensor has tubular shape and is fabricated of fiberglass tube with electrostatic screen and outer protective coating. The front panel to which cable connector, electronic boards and sensor core with all windings are fastened can be removed in order to procure the access to all sensor elements. 

The sensor and cable connector is hermetically sealed. It allows operation of LEMI-30 sensor at humidity up to 100%,


but do not immerse the sensors into water!


The opening of the sensor housing before the end of guarantee terms without written permission of Manufacturer cancels all guarantee obligations of the latter.


5.9. Communication and measuring unit (CAM-Unit) has been designed especially for LEMI-30 magnetometers. 

5.10. CAM-Unit operation can be explained using CAM-Unit block diagram (Fig 4.). Analogous outputs of the sensors are connected to instrumental programmable gain amplifiers (PGA). The analogous signals are filtered inside CAM-Unit by low-pass filters (LPF) from stray signals and then converted into digital form by ADCs. ADC conversion of every sensor output is made almost simultaneously (delay is about 0,2 ms) to ensure high resolution timing. The operation software allows setting the gain of PGA to 1, 10, 100 or 1000 through CPU built-in program. CPU provides functioning of ADC, downloading and uploading of data through RS-232 interface, receiving GPS data and several additional functions.


The POWER supply unit provides necessary voltages to the sensors and CAM-Unit electronics. 


The sync unit generates the signal with frequency 256 Hz for ADC conversion synchronization. This signal is synchronized with 1-second sync signal of built-in GPS card.
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Fig 4. CAM-Unit functional diagram.

5.11. The CAM-Unit connectors pin allocation is given on Fig. 5. It is powered by dc current supply voltage +12 V. The total supply current including powering of 3 induction coil sensors does not exceed 250 mA in all operation modes.

5.12. CAM-Unit power input is protected from over voltage with fuse 0.5A and from wrong polarity by built-in diode.
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Fig.5. CAM Unit Pins Allocation
6. Operation Instructions

6.1. Preparation for Operation

6.1.1. Read the present Manual, check the set of delivery and the absence of outer damages.

6.1.2. Install the sensors according to Fig. 1. of Appendix A and the requirements given there at a site where measurements have to take place. The sensor hole must be kept dry. Sensors must be covered over with sand and the hole must have to be covered after installation with waterproof cover.

 No magnetic materials have to be used.

6.1.3. Place CAM-Unit near data storing PC at the distance from the sensor installation site no more than 200 meters.

6.1.4. Connect the sensors to CAM-Unit using special cables (cable wiring as on Fig. 6.). Each cable for the sensors has to have five twisted pairs of multiple-strand wires, all in one common shield. Cross-section of each wire must be not less than 0.2 square mm. The length of each cable must be the same as a distance between observation point and data collection site plus 10 meters reserve. Maximal allowed cable length is 200 meters.

To avoid water and moisture penetration into connector, we recommend enclosing connector and adjacent part of the cable (~10-15 cm) together into heat-shrinkage insulation tube. 

Attention: All three cables from the sensors to CAM-Unit have to be connected in accordance with the directions of sensors installation to Bx, By and Bz connectors of CAM-Unit.

6.1.5. Plug the GPS antenna into GPS socket on the front panel of CAM-Unit. GPS antenna must be placed outside of a building and has not be shadowed by trees.

6.1.6. Do all preparatory work concerning the data storing software, following the Software Manual.
6.1.7. Couple the RS-232 connector of CAM-Unit and COM1 Port of the PC with the cable RS232-COM1. In case of absence the COM Port in the PC uses the converter USB2.0TORS232 MOXA 1110.
 Connect the adapter MOXA 1110 (USB - RS-422) supplied with the magnetometer to USB port and install the drivers (see MOXA datasheet). Connect the RS-232 cable to the DB9 MOXA 1110 connector.
6.1.8. Plug the power supply cable into +12 V socket on the rear panel of the CAM-Unit and connect it to the battery power supply 12 V.

6.1.9. In the case when the 220 V AC mains is available AC/DC adaptor may be used.
NOTE: The PC has to be dedicated to the operation with LEMI-30 only; no other tasks have to be fulfilled simultaneously if the right operation of the LEMI-30 - PC system is expected to have. It is necessary to take a special care to disable in such a PC the Wi-Fi unit, as well as any running programs requiring external connection, such as antivirus program, Internet Explorer and so on! 
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Fig.6. Cable wiring
The length of the cable has to be more than 30 m less then 200 m. Type of the cable: HELUKABEL PAAR-TRONIC-CY 4x2x0,25 QMM /21037 (example) or similar (4 twisted pairs in shield).
  6.2. Operation

6.2.1. Turn on the CAM-Unit. In few minutes green LED on the CAM- Unit front panel must go off, then periodically blink on and off once in two seconds. It means that GPS is operating.

6.2.2. The system is ready for operation one minute after switching the power supply on. However, to obtain low noise at frequencies lower than 0.1 Hz it is highly recommended to turn the system on 10 minutes before data acquisition.

6.2.3. All further operations are carried out through LEMI-30i Logger program
6.3. LEMI-30i Logger description

6.3.1. LEMI-30i Logger is intended for recording of data from LEMI-30 induction coil magnetometers acquired by CAM-Unit and for handling commands to CAM-Unit through its graphic user interface.

6.3.2. LEMI-30i Logger is used for:

· handling commands to CAM-Unit through graphic user interface;

· storing data from CAM-Unit on PC hard-disc;

· real-time visualization of recorded data;

· visualization of previously recorded data.

6.3.3. Connection of PC with CAM-Unit is realized through serial COM-port interface. USB-to-COM adaptor may be used in case no COM Port connector is available in PC. 
6.3.4. Lemi-30i Logger consists of 5 files. 

	1
	lemi30ilogger .exe
	Win32 application

	2
	*.lem
	Binary data file

	3
	lemi.ini
	Ini-file

	4
	lemi.log
	Log-file

	5
	lemi.chm
	Help-file


All files must be stored in the same directory on the portable PC.

6.3.5. Run lemi30ilogger .exe.

[image: image12.jpg]


6.3.6. LEMI-30i Logger window in its main operation mode (Fig. 7) includes three charts for real-time visualization of recorded data. No charts are visible (see Fig 8.) when visualization is turned off. All main visual controls are shown by red arrows with corresponding red text.

Fig 7. LEMI-30i Logger window.

[image: image13.emf]
Fig 8. LEMI-30i Logger window (real-time visualization is off).

6.3.7. LEMI-30i Logger main menu consists of:

· File -> Open…
            Output directory…
            Exit

· Options

· Remarks

· ComPort

· Help -> LEMI-30i Logger help

            About

6.3.8. For reviewing of files recorded earlier, click File -> Open…, and follow usual MS Windows routine.

6.3.9. To set directory where all data files will be stored, click File -> Output directory… and follow usual MS Windows routine.

6.3.10. To close lemi30ilogger.exe, click File-> Exit.

6.3.11. To set options click Options. Window Options should appear (see Fig 9. for details).


6.3.12. Sampling rate is a parameter that defines the number of samples which will be recorded on hard disc during one second of measurements. The ADC sampling rate is constant and equals to 256 samples per second per channel. Taking into account that LEMI-30 sensors frequency range is up to 30 Hz, sampling rate has to be not lower than 64 Hz. To avoid frequency aliasing, powerful filters are built both in LEMI -30 sensors and in input stages of CAM-Unit. ADC high sampling rate eliminates almost any possibility of aliasing problem. The problem may occur only in areas with very powerful industrial noise, for instance near energy distributing lines or power plants where magnetic field is inhomogenous. 
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Fig 9. LEMI-30i Logger Options window.


6.2.13. Sensitivity parameter is the factor by which ADC output should be multiplied to get data rated in nT.  

Note. Sensitivity must be set to 2.393e-5 nT/bit if CAM-Unit is connected to LEMI-30 sensors output with 20mV/nT transformation factor. 

6.3.13. LEMI-30i Logger can open new file every midnight of every hour. Click on appropriate radio button to choose.

6.3.14. Click OK to save options and return to main menu.

6.3.15. Real time visualization combo box allows accommodating in the charts 1, 10 or 60 minutes of data. Choose the appropriate option.


6.3.16. Every time before acquisition is started, remarks can be added to the new file by clicking on Remarks and following usual MS Windows routine after Remarks window (Fig 10.) appear. The length of text cannot exceed 1024 symbols.
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Fig 10.  LEMI-30i Logger Remarks window.


6.3.17. In order to choose appropriate COM-Port (in case PC has more than one Com-port), click on ComPort and choose the COM-Port to which interface cable from CAM-Unit is connected.


6.3.18. Gain combobox allows to set CAM-Unit PGA gain between 1, 10, 100 and 1000.


6.3.19. To test functionality of LEMI-30 sensors, click on Calibration button. When Calibration button has ON inscription, 10 Hz 5 Vptp sinewave signal is applied to LEMI-30 sensors. Press Calibration button once more to turn the calibration signal OFF.


6.3.20. If real time visualization button inscription is ON then there are three charts in LEMI-30 Logger window on which data samples are drawn. See Options menu for details.


6.3.21. Press Start button to start data acquisition.


6.3.22. Press Stop button to stop data acquisition.

6.3.23. Press GPS button to get GPS information. While getting GPS information data acquisition is suspended.
Typical GPS info: 

“4947.939,N 02400.541,E 00343,M (2005 09 22 14 09 12)” – latitude, longitude, altitude (above sea level) and time accordingly.

6.3.24. Time, Bx, By, Bz data and GPS information is shown at the bottom of LEMI-30i Logger window.


6.3.25. Binary data file format is described in Appendix C.


6.3.26. Configuration settings of LEMI-30i Logger are stored in file “lemi.ini“.

6.3.27. Log file “lemi.log”is created automatically for storing protocol information such as:

· start time; 

· stop time;

· data files created;

· LEMI-30i Logger commands;

· replies of CAM-Unit to LEMI-30 Logger commands;

· GPS availability;

· error messages;

· etc.

Typical log-file:

20.09.2005 20:07:08: Start program

20.09.2005 20:07:10: GPS data: 4947.905,N 02400.520,E 00364,M (2005 09 20 17 07 51)

20.09.2005 20:30:33: GPS: Available. 17 31 14

20.09.2005 20:30:33: Start= 20050920173115.lem

20.09.2005 20:40:35: Stop = 20050920173115.lem

20.09.2005 20:35:15: Exit program


6.3.28. Log-file contains very important information about system behavior. This file is to be archived and sent to leon@isr.lviv.ua every time some error happened in order to enable LEMI-30i Logger debugging. The last 10 events could be reviewed in log-combobox at the bottom part of LEMI-30i Logger window.
6.4. Data acquisition


To start data acquisition please follow steps:


6.4.1. Set current Output Directory


6.4.2. Choose appropriate settings in Options menu. 

Recommended options are: 

· sampling rate set to 64 Hz, 

· sensitivity set to 2.393e-5 nT/bit,

· open new file set to every midnight,

· real time visualization set to minutes on screen  1,

· gain set to 10 (depends on the measurement site electromagnetic pollution).


6.4.3. Choose COM-port to which interface cable was connected during hardware installation


6.4.4. Press Start button to start data acquisition. Several seconds are required by hardware to begin acquisition.

6.4.5. If in the Log-combobox new file name is displayed then acquisition is started correctly. Follow prompts in the combobox otherwise.

6.5. Transportation

6.5.1. After all operations with the LEMI-30 magnetometer are over turn off the CAM-Unit.

6.5.2. Disconnect all cables from the sensors and the CAM-Unit.

6.5.3. Disconnect the GPS antenna from the CAM-Unit.

6.5.4. Pack all equipment into corresponding transportation boxes using elastic gaskets if possible. The magnetometer is ready for transportation.

6.5.5. Avoid the shocks of the magnetometer more than 10 g and vibrations in frequency band 1—1000 Hz with accelerations more than 5 g, especially in transversal directions.
Appendix A. Recommendations for observatory continuous measurement site installation
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Fig. 1. LEMI-30 installation site

Recommendations

1. All dimensions of the sensor hole are given for orientation - any deviations in bigger side are possible.

2. The hole has to be covered with any hut against rain and wind, the external dimensions of which have to be at least 20 mm bigger than the hole dimensions.

3. The hut has to be made from non-magnetic and non-conductive material.

4. The edges of the concrete walls have to be at least 30-50 mm above the ground level in order to protect from water when covered by the hut.

5. It is necessary to foresee small gaps between inner part of the hut and the edges of concrete walls in order to allow the outer air inside freely.  

6. To avoid water and moisture penetration into connector, we recommend enclosing connector and adjacent part of the cable (~10-15 cm) together into heat-shrinkage insulation tube.
Appendix B. The recommendation of the selection of experiment conditions
1. The measurement should be carried out in electromagnetically clean place, by this to take into account possible magnetic signals from, e.g., nearby thunderstorms, solar bursts etc. The sensor should be located as far as possible from power mains lines and large ferromagnetic objects. It is difficult to give accurate recommendations about distance, because it depends on magnetic moment of such objects; the minimal distance should be about 200 m. For example, at the sensor outputs we clearly observe process of opening and closing of the car door at the distance more than 15 meters. Do not select measurement sites near big trees - strong wind will produce soil oscillations too and consequently sensor vibrations. The distance between each of the three sensors in a three-components set has to be more than 1 meter, recommended about 2.5 meters.

2. It should be made maximum efforts to provide stable positions of the sensor (e.g., the 1" rotation of the sensor in the Earth magnetic field can produce ~250 pT of parasitic signal). For this purpose it is necessary to bury the sensor in the ground, if there is a temporary station, or make beds (holes) with concrete walls if there is a permanent location. If there are supposed microseisms in the region better to fill the concrete bed to the half of depth with elastic material, e.g. as packing soft polyurethane, and to put the sensor at such material. Its cable has also to be buried, at least the first three-five meters of the part connected to the sensor. The cover from rain should be foreseen too. Such installation procedure allows avoiding wind blows influence and also decreases sensor temperature fluctuations. 

3. To connect the sensor to the acquisition system proceeds in following way. A sensor cable, which has to be prepared of the necessary length (preferably shorter than 100 meters) should contain 3 twisted wires for power supply, two (or at least one) shielded twisted pairs for signal and one wire for analog ground.

4. Very important is good quality of power supply, especially in high-frequency range. Best way is to use battery; by this the battery should be placed on insulating support, e.g., polyethylene film.

5. If you have DC-DC transformers in your receiving equipment, you have also to make sure that they do not produce noises, especially spikes, in the input circuits of the equipment.

Appendix C. Binary data file description

General notes

Each separate data file contains only one day (or one hour) data. Data are stored in binary format, except file header, which is stored as XML-text. Therefore, the datafile is divided in two parts: XML-header and data itself. In its turn, data part consists of one-second records. Each one-second record consists of a one-second header (where all data of time, GPS, gain and calibration status are stored) and one-second data block. The length of all one-second records in the datafile is constant. In case of errors, missing data, etc. necessary parts are filled with NAN (Not-a-Number) code to keep one-second record size constant.

The size of one-second record equals to: 

One-second size in bytes = 4 bytes for one-second header + sampling rate * number of channels * 4 bytes per sample

For example, if sampling rate is 64 samples per second, second size in bytes is equal to:
one-second size in bytes = 4 + 64 * 3 * 4 = 772 bytes

And the one day datafile size equals to:
file size in bytes = size of XML-header in bytes + second size * 86400 seconds per day

Skipped data


Skipped data are replaced by NAN code (7F FF FF FF hex). It helps to keep the datafile size always constant.

File names

The datafile name has the following template: 

YYYYMMDDHHMMSS.lem

Where:

YYYYMMDD - date and HHMMSS - time when recording started.

YYYY - year,- 2001, 2002, ...
MM - month,- 01 ... 12
DD - day,- 01... 31
HH - hour, 0...23
MM - minute, 0...59
SS - second, 0...59

Datafile structure

Datafile structure is:

	XML file header
	See below

	one-second header
	status byte, hour, minute, second - 4 bytes totally

	one-second data
	total size of second data:
sampling rate * channels * 4 bytes per sample

	one-second header
	always by 1 second higher to the previous second header

	one-second data
	 

	and so on...


In one day data file always 86400 seconds are stored.

XML datafile header

XML file header conforms to standard XML specification. It contains following tags:

	Tag
	Value
	Comments

	lemi_header
	 
	root tag, attribute version="lemi30i2" specifies file format version 

	year
	 
	Datafile date. Each day (or each hour) new datafile created. One datafile could cotain only one day (or one hour) data - so in second headers only time is stored

	month
	 
	

	day
	 
	

	base_sampling_rate
	256
	base sampling rate is always 256 samples per second

	averaging
	 
	sum of how many samples are stored as one sample in file. Could be from 1 (no averaging - actual sampling rate equals to base sampling rate) to 256 (actual sampling rate - one sample per second)

	samplingrate
	 
	equals to base sampling rate divided by averaging

	sensitivity
	
	how many nT corresponds to 1 bit of ADC converter, always constant

	gain
	 
	additional gain, could be 1,10,100 or 1000

	bit_to_nT
	 
	Transfer coefficient - from data in file to measuring value in nT. To get measured value, one should multiply each sample stored in file by this coefficient.
bit_to_nT = sensitivity / gain / averaging

	channels
	3
	number of channels. Always 3, which corresponds to X, Y and Z

	bytes_per_sample
	4
	number of bytes per one sample ( always 4 )

	one_second_record_size_in_bytes
	 
	number of bytes per one second data (see above)

	GPS
	 
	GPS coordinates:

	longitude
	 
	longitude

	lattitude
	 
	lattitude

	altitude
	 
	attitude

	remarks
	
	remarks (maximum length 1024 symbols)


XML header is finished by closing </lemi_header> tag and carriage return (0x0D, 0x0A).

Typical xml-header:

<? version="1.0" encoding="windows-1251"?>

<lemi_header version="lemi30i2">


<year>2005</year>


<month>09</month>


<day>28</day>


<base_sampling_rate>256</base_sampling_rate>


<averaging>4</averaging>


<samplingrate>64</samplingrate>


<sensitivity> 2.44000000000000E-0005</sensitivity>


<gain>10</gain>


<bit_to_nT> 6.10000000000000E-0007</bit_to_nT>


<channels>3</channels>


<bytes_per_sample>4</bytes_per_sample>


<one_second_record_size_in_bytes>772</one_second_record_size_in_bytes>


<GPS>



<longitude></longitude>



<lattitude></lattitude>



<altitude></altitude>


</GPS>


<remarks></remarks>

</lemi_header>

One-second header and data

	status byte
	1 byte
	char
	Second header 

  

	hour
	1 byte
	char
	

	minute
	1 byte
	char
	

	second
	1 byte
	char
	

	X channel sample
	4 bytes
	integer
	Total number of samples equals to number of channels (3) * sampling rate

	Y channel sample
	4 bytes
	integer
	

	Z channel sample
	4 bytes
	integer
	

	....
	 
	 
	

	X channel sample
	4 bytes
	integer
	

	Y channel sample
	4 bytes
	integer
	

	Z channel sample
	4 bytes
	integer
	

	....
	 
	 
	


Status byte

	bit
	7
	6
	5
	4
	3
	2
	1
	0

	meaning
	not used
	GPS status

0 - not available
1 - GPS OK
	calibration
1 - off
0 - on
	bit1
	bit0
	gain

	
	
	
	
	0
	0
	1

	
	
	
	
	0
	1
	10

	
	
	
	
	1
	0
	1000

	
	
	
	
	1
	1
	1000


 

Appendix D.  Transformation factor values
The first line contains frequency in Hz, the following lines contain transformation factor (S) values in mV/nT measured with error 2% and phase shift in degrees of angle between input and output signals.

For all magnetometers the parameters at 0.001 Hz and 0.01 Hz are obtained by calculation.

	f, Hz
	0.001
	0.01

	S, mV/nT
	0.02
	0.2

	Phase, °
	90
	89


LEMI-30 №394
	f, Hz
	S, mV/nT
	Phase, (

	2.1000E-2
	3.831E-1
	8.8757E1

	3.1770E-2
	5.782E-1
	8.8095E1

	4.8062E-2
	8.739E-1
	8.7235E1

	7.2711E-2
	1.317E0
	8.5811E1

	1.1000E-1
	2.001E0
	8.3907E1

	1.3347E-1
	2.396E0
	8.1958E1

	1.6196E-1
	2.911E0
	8.0865E1

	1.9652E-1
	3.507E0
	7.8443E1

	2.3846E-1
	4.236E0
	7.6217E1

	2.8934E-1
	5.106E0
	7.3502E1

	3.5109E-1
	6.103E0
	7.0305E1

	4.2601E-1
	7.262E0
	6.6136E1

	5.1692E-1
	8.568E0
	6.1596E1

	6.2723E-1
	9.992E0
	5.6427E1

	7.6108E-1
	1.152E1
	5.0446E1

	9.2349E-1
	1.307E1
	4.3939E1

	1.1206E0
	1.457E1
	3.6817E1

	1.3597E0
	1.592E1
	2.9308E1

	1.6498E0
	1.708E1
	2.1734E1

	2.0019E0
	1.804E1
	1.3981E1

	2.4291E0
	1.878E1
	6.0387E0

	2.9475E0
	1.932E1
	-2.0682E0

	3.5765E0
	1.970E1
	-1.0483E1

	4.3397E0
	1.994E1
	-1.9479E1

	5.2658E0
	2.006E1
	-2.9275E1

	6.3895E0
	2.009E1
	-4.0205E1

	7.7530E0
	2.003E1
	-5.2702E1

	9.4075E0
	1.990E1
	-6.7212E1

	1.1415E1
	1.969E1
	-8.4412E1

	1.3851E1
	1.941E1
	-1.0509E2

	1.6807E1
	1.909E1
	-1.3072E2

	2.0393E1
	1.865E1
	-1.6372E2

	2.4745E1
	1.759E1
	1.5143E2

	3.0026E1
	1.431E1
	8.7260E1


LEMI-30 N425
	f, Hz
	S, mV/nT
	Phase, (

	2.1000E-2
	3.879E-1
	8.8414E1

	3.1770E-2
	5.819E-1
	8.8110E1

	4.8062E-2
	8.790E-1
	8.7171E1

	7.2711E-2
	1.322E0
	8.5850E1

	1.1000E-1
	2.009E0
	8.3723E1

	1.3347E-1
	2.432E0
	8.2218E1

	1.6196E-1
	2.940E0
	8.0760E1

	1.9652E-1
	3.541E0
	7.8522E1

	2.3846E-1
	4.292E0
	7.6052E1

	2.8934E-1
	5.121E0
	7.3414E1

	3.5109E-1
	6.142E0
	7.0133E1

	4.2601E-1
	7.301E0
	6.6173E1

	5.1692E-1
	8.622E0
	6.1358E1

	6.2723E-1
	1.002E1
	5.6108E1

	7.6108E-1
	1.156E1
	5.0239E1

	9.2349E-1
	1.311E1
	4.3679E1

	1.1206E0
	1.460E1
	3.6618E1

	1.3597E0
	1.596E1
	2.9240E1

	1.6498E0
	1.710E1
	2.1497E1

	2.0019E0
	1.805E1
	1.3789E1

	2.4291E0
	1.877E1
	5.9729E0

	2.9475E0
	1.930E1
	-2.1212E0

	3.5765E0
	1.968E1
	-1.0459E1

	4.3397E0
	1.992E1
	-1.9391E1

	5.2658E0
	2.006E1
	-2.9132E1

	6.3895E0
	2.010E1
	-4.0018E1

	7.7530E0
	2.006E1
	-5.2456E1

	9.4075E0
	1.996E1
	-6.6934E1

	1.1415E1
	1.977E1
	-8.4126E1

	1.3851E1
	1.957E1
	-1.0487E2

	1.6807E1
	1.926E1
	-1.3059E2

	2.0393E1
	1.883E1
	-1.6377E2

	2.4745E1
	1.772E1
	1.5111E2

	3.0026E1
	1.429E1
	8.6744E1


LEMI-30 N426

	f, Hz
	S, mV/nT
	Phase, (

	2.1000E-2
	3.821E-1
	8.8640E1

	3.1770E-2
	5.780E-1
	8.8025E1

	4.8062E-2
	8.731E-1
	8.7186E1

	7.2711E-2
	1.317E0
	8.5938E1

	1.1000E-1
	1.992E0
	8.3727E1

	1.3347E-1
	2.414E0
	8.2265E1

	1.6196E-1
	2.913E0
	8.0318E1

	1.9652E-1
	3.500E0
	7.9035E1

	2.3846E-1
	4.224E0
	7.6497E1

	2.8934E-1
	5.078E0
	7.3623E1

	3.5109E-1
	6.090E0
	7.0234E1

	4.2601E-1
	7.241E0
	6.6293E1

	5.1692E-1
	8.556E0
	6.1479E1

	6.2723E-1
	9.973E0
	5.6382E1

	7.6108E-1
	1.149E1
	5.0432E1

	9.2349E-1
	1.305E1
	4.3918E1

	1.1206E0
	1.453E1
	3.6877E1

	1.3597E0
	1.589E1
	2.9484E1

	1.6498E0
	1.705E1
	2.1782E1

	2.0019E0
	1.800E1
	1.4078E1

	2.4291E0
	1.874E1
	6.2154E0

	2.9475E0
	1.928E1
	-1.8803E0

	3.5765E0
	1.966E1
	-1.0217E1

	4.3397E0
	1.990E1
	-1.9154E1

	5.2658E0
	2.004E1
	-2.8876E1

	6.3895E0
	2.008E1
	-3.9742E1

	7.7530E0
	2.004E1
	-5.2148E1

	9.4075E0
	1.993E1
	-6.6582E1

	1.1415E1
	1.974E1
	-8.3678E1

	1.3851E1
	1.950E1
	-1.0433E2

	1.6807E1
	1.922E1
	-1.2990E2

	2.0393E1
	1.877E1
	-1.6284E2

	2.4745E1
	1.769E1
	1.5240E2

	3.0026E1
	1.433E1
	8.8462E1


LEMI-30 N431

	f, Hz
	S, mV/nT
	Phase, (

	2.1000E-2
	3.779E-1
	8.8661E1

	3.1770E-2
	5.712E-1
	8.8155E1

	4.8062E-2
	8.644E-1
	8.7259E1

	7.2711E-2
	1.305E0
	8.5922E1

	1.1000E-1
	1.974E0
	8.4194E1

	1.3347E-1
	2.382E0
	8.2337E1

	1.6196E-1
	2.881E0
	8.0869E1

	1.9652E-1
	3.470E0
	7.9107E1

	2.3846E-1
	4.179E0
	7.6600E1

	2.8934E-1
	5.036E0
	7.3717E1

	3.5109E-1
	6.032E0
	7.0391E1

	4.2601E-1
	7.192E0
	6.6399E1

	5.1692E-1
	8.492E0
	6.1795E1

	6.2723E-1
	9.904E0
	5.6646E1

	7.6108E-1
	1.143E1
	5.0740E1

	9.2349E-1
	1.298E1
	4.4169E1

	1.1206E0
	1.449E1
	3.7062E1

	1.3597E0
	1.586E1
	2.9510E1

	1.6498E0
	1.703E1
	2.1881E1

	2.0019E0
	1.801E1
	1.4036E1

	2.4291E0
	1.878E1
	6.0204E0

	2.9475E0
	1.932E1
	-2.2537E0

	3.5765E0
	1.969E1
	-1.0773E1

	4.3397E0
	1.993E1
	-1.9932E1

	5.2658E0
	2.004E1
	-2.9884E1

	6.3895E0
	2.005E1
	-4.1000E1

	7.7530E0
	1.996E1
	-5.3683E1

	9.4075E0
	1.978E1
	-6.8404E1

	1.1415E1
	1.950E1
	-8.5795E1

	1.3851E1
	1.915E1
	-1.0669E2

	1.6807E1
	1.875E1
	-1.3244E2

	2.0393E1
	1.821E1
	-1.6544E2

	2.4745E1
	1.717E1
	1.4989E2

	3.0026E1
	1.425E1
	8.5672E1


LEMI-30 N435
	f, Hz
	S, mV/nT
	Phase, (

	2.1000E-2
	3.855E-1
	8.8945E1

	3.1770E-2
	5.797E-1
	8.8088E1

	4.8062E-2
	8.761E-1
	8.7093E1

	7.2711E-2
	1.321E0
	8.5875E1

	1.1000E-1
	1.992E0
	8.3613E1

	1.3347E-1
	2.404E0
	8.1656E1

	1.6196E-1
	2.927E0
	8.0825E1

	1.9652E-1
	3.510E0
	7.8448E1

	2.3846E-1
	4.256E0
	7.6571E1

	2.8934E-1
	5.128E0
	7.3648E1

	3.5109E-1
	6.099E0
	7.0264E1

	4.2601E-1
	7.259E0
	6.6372E1

	5.1692E-1
	8.579E0
	6.1545E1

	6.2723E-1
	9.994E0
	5.6351E1

	7.6108E-1
	1.153E1
	5.0420E1

	9.2349E-1
	1.305E1
	4.3947E1

	1.1206E0
	1.455E1
	3.6875E1

	1.3597E0
	1.592E1
	2.9323E1

	1.6498E0
	1.706E1
	2.1749E1

	2.0019E0
	1.801E1
	1.3975E1

	2.4291E0
	1.875E1
	6.1134E0

	2.9475E0
	1.930E1
	-1.9235E0

	3.5765E0
	1.967E1
	-1.0283E1

	4.3397E0
	1.991E1
	-1.9209E1

	5.2658E0
	2.005E1
	-2.8944E1

	6.3895E0
	2.008E1
	-3.9813E1

	7.7530E0
	2.004E1
	-5.2222E1

	9.4075E0
	1.992E1
	-6.6656E1

	1.1415E1
	1.974E1
	-8.3744E1

	1.3851E1
	1.950E1
	-1.0439E2

	1.6807E1
	1.918E1
	-1.2991E2

	2.0393E1
	1.875E1
	-1.6284E2

	2.4745E1
	1.767E1
	1.5235E2

	3.0026E1
	1.428E1
	8.8271E1


LEMI-30 N437
	f, Hz
	S, mV/nT
	Phase, (

	2.1000E-2
	3.828E-1
	8.8889E1

	3.1770E-2
	5.801E-1
	8.8102E1

	4.8062E-2
	8.736E-1
	8.7108E1

	7.2711E-2
	1.322E0
	8.5908E1

	1.1000E-1
	1.994E0
	8.3406E1

	1.3347E-1
	2.419E0
	8.2206E1

	1.6196E-1
	2.916E0
	8.0658E1

	1.9652E-1
	3.536E0
	7.9050E1

	2.3846E-1
	4.248E0
	7.6228E1

	2.8934E-1
	5.096E0
	7.3748E1

	3.5109E-1
	6.098E0
	7.0194E1

	4.2601E-1
	7.268E0
	6.6217E1

	5.1692E-1
	8.580E0
	6.1446E1

	6.2723E-1
	9.987E0
	5.6170E1

	7.6108E-1
	1.150E1
	5.0239E1

	9.2349E-1
	1.304E1
	4.3702E1

	1.1206E0
	1.451E1
	3.6636E1

	1.3597E0
	1.587E1
	2.9285E1

	1.6498E0
	1.702E1
	2.1556E1

	2.0019E0
	1.795E1
	1.3871E1

	2.4291E0
	1.869E1
	6.0173E0

	2.9475E0
	1.921E1
	-2.0003E0

	3.5765E0
	1.957E1
	-1.0312E1

	4.3397E0
	1.982E1
	-1.9252E1

	5.2658E0
	1.996E1
	-2.8954E1

	6.3895E0
	2.000E1
	-3.9803E1

	7.7530E0
	1.996E1
	-5.2198E1

	9.4075E0
	1.985E1
	-6.6618E1

	1.1415E1
	1.967E1
	-8.3747E1

	1.3851E1
	1.943E1
	-1.0438E2

	1.6807E1
	1.914E1
	-1.2997E2

	2.0393E1
	1.870E1
	-1.6292E2

	2.4745E1
	1.762E1
	1.5232E2

	3.0026E1
	1.427E1
	8.8409E1


Appendix E. Typical noise spectral density

Noise spectral density was measured in field by subtraction of output signals of the two magnetometers placed in similar conditions. Green and blue curves are output signals spectra of two LEMI-30 magnetometers. The red curve is noise level of LEMI-30 magnetometer.  
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